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  Welcome 2011 
  

As we usher in a new year, BGAMUG is proud 
to announce some special things. 
 
First of all, take a look at our new website; 
www.bgamug.org . Betsy has been busy with 
the new look and has done a fantastic job. 
 
Second is our February Special Internet Security 
Presentation Event with guest speaker and PC 
Evangelist Charley Prince will visit BGAMUG 
immediately following a trip to the RSA secu-
rity conference in San Francisco the week of 
February 13th - 19th. 
 
Read all about what Charley has been doing on 
page 7. 
 
We will be advertising this event in the media 
and are counting on members to pick up flyers 
at the meeting to help spread the word and en-
courage a good attendance. 
 
                           

Now,   if only the weather will cooperate ?? 
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**January Program** 
Create Photo  
Movie DVD’s 

With Windows Movie Maker 
 

By:  Ray Eddy & 
Jerry Gillette           
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FEBRUARY 2011 
Su Mo Tu We Th Fri Sa

    1 2 3 4 5 
6 7 8 9 10 11 12 
13 14 15 16 17 18 19
20 21 22 23 24 25 26 
27 28           

November 
BGAMUG  

DOOR PRIZE  WINNERS   
 

Door Prize winner: Paula Niece 
4GB  Sport Thumb Drive 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$ 
 

????Door Dollar$ Winner???? 
Would you believe …  Paula Niece also 
won the $20 Door $ Pot. This is the first 

time anyone has won both.  
One Lucky Lady. 

 

The pot is  $10.00 for January  
Remember you must be present to win. 

 
BGAMUG Treasurer's  

Report 
           December – 2010 
        Paula Niece, Treasurer 

November  period:    11/30/10 – 12/31/10 

Starting Balance………………....  $    1,298.96 
Income…………………………..  $          25.07 
Expenses……………….………..  $        309.49 
Ending Balance………………..… $    1,014.54 

 

 

                      KROGER REPORT 
BGAMUG members–  
We are less than $1,000 away from receiving a 
check. 
Everyone keep reloading cards and I still have a 
few available for purchase. 
 

Thanks,  Paula Niece 
Kroger Repesentative 
 

Shirley Sublett        2/5 
Jonathan Morrell    2/11 
Jerry Phelps           2/11 
Jeri Steele             2/16 
Gary Wickliff          2/24 

E-Board Party 

JANUARY 2011 
Su Mo Tu We Th Fri Sat 

2 3  4  5  6 7 8 
9 10 11 12 13 14 15 
16 17 18 19 20 21 22 
23 24 25 26 27 28 29 
30   31           
       

1-16 Lou Travelsted 
1-17 John Walker 
1-20 Edwin Phelps 
1-25 Elizabeth Rose 
1-26 Wilma Smith 
1-29 Gilbert Lakes 

1-5 Robert and Wanda Hunt 
1-24 Clifford and Martha Hayes 
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BGAMUG General Meetings are on the 4th Tuesday of 
each month.  These meetings are at the Bowling Green 
Technical College, Bldg F, at 6:30 PM.   See the map.  The 
entrance to the BGTC campus on Loop Drive is clearly 
marked.  Building 5 is the last building on the left, down the 
road through the campus.   
 
BGAMUG Board Meetings are on the first Tuesday of 
each month . The next board meeting will be on Tuesday,  
February 1st. The location will be announced by email.   
The business meeting will begin at 6:30pm. 
 

January meeting will be in the F  Building… 
 

Need to advertise your business???                         
ADVERTISING RATES  are listed on page 10. 

The Bowling Green Area 
 Microcomputer  

Users Group is a dedicated  
gathering of local computer users 

who enjoy learning about their 
systems and teaching others 
about  these  

wonderful tools that can transform our lives. 

 

We Need “You” on Our List 
 

Two or three years ago we started including interested members in the Eboard Email List. The reason being that 
everything officers that make up the eboard do is discuss and make decisions on the members behalf. 

 
We would like to give all members the opportunity to follow and comment anytime on what business is being 

discussed among officers. When we get replies from members on various issues, it has a very big influence on the decisions we make. 
 

There is no obligation that you reply to all messages.  
Only the ones you have an interest in and a comment or suggestion to make. 

 
If you would like to be included in Officer Email Discussions,  

please email myself, Jerry Gillette at JAGKY@INSIGHTBB.COM 
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APCUG Election Report  by Marie Vesta 
The 2010 election for the year 2011 was  
held the month of November, 2010.  
A successful election was held with  
over 80 User Group Members casting 
 their votes for the APCUG’s Board of  
Directors and Board of Advisors.  
From the 80+ groups that voted, 27 s 
tates and Canada were represented. 
 All regions participated in the voting  
process. 
Board of Directors for 2011: 
Kathy Jacobs, Don Singleton, Linda Moore,  
Claudette Marshall, David Gerber, Marie  
Vesta, Hewie Poplock (reelected), Jim Evans 
(newly elected), and Clint Tinsley  
(newly elected). 
Board of Advisors for 2011: 
Sam Wexler, Robert Vance, Jeri Steele,  
David Steward, Gabe Goldberg, Bill James  
(reelected), Patty Lowry (reelected), Ed 
Roberts (reelected), Stu Silverman 
 (reelected), Roger Tesch (reelected),  
David Williams (newly elected), and  
Carl Loftstrom (newly elected). 
Respectfully submitted, 
Marie Vesta, Election Chair 
Kathy Jacobs, Bob Vance 

APCUG Photo and 
Newsletter Contest Coming 

APCUG’s Annual Photo Contest for 2011 
Tell your members to get there camera’s ready, the an‐
nual APCUG Photo contest will soon be announced. Some‐
where inside of all of us is a creative genius just waiting 
for the chance to grab the spotlight…and we want to give 
you that chance. There will be multiple chances to 
win….including… professional judging and our own “Photo 
Idol” chosen from the ‘best of the best’, so grab those 
cameras and start shooting! Announcement coming soon! 

So Much To Do 
In Such Little Time 

 
Handouts & Online Tutorials to 

the Rescue 
 
Everyone knows the presentations we offer in 
BGAMUG each month only scratches the surface 
regarding the various topics. After all, a presenta-
tion is only an overall view of what is available 
and a demonstration on how to achieve some basic 
tasks. 
 
To expand the learning experience and give our 
members the opportunity to get more from our in-
troductory presentations we often use handouts. 
These usually contain references and instructions 
where attendees can continue learning from home 
while at their PC’s. 
 
In search of the many topics to cover during our 
upcoming Windows Movie Maker Presentation, I 
stumbled upon a fantastic site with Google. 
 
The Site:  http://www.atomiclearning.com 
 
On automaticlearning.com there is a magnitude of 
topics without the need to log-on and become a 
site member. For example, the site offers video tu-
torials for currently 620 leading software titles, 
both old and new. Each tutorial is broken down 
into short one to three minute narrated segments, 
allowing the user to select just the ones that may 
apply to them. The Windows Movie Maker Tuto-
rial; 
 
http://www.atomiclearning.com/moviemaker2 
 
consists of ten categories with 63 detailed clips. To 
view all the clips would take about two hours. 
 
I was very impressed with the clarity and simplic-
ity of instructions. 
 
Treat yourself by visiting this site. You may wish 
to add it to your favorites. 

Jerry Gillette 
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Using a Personal Computer, Intro Level Marcel Parent, Instructor 
Community Education welcomes new instructor Marcel Parent, of MountMars Consulting. 
In this introductory class you will become familiar with all the parts that make up a 
computer and learn the basics of Windows as you learn to use the mouse, change settings, 
organize files, edit documents, save and create files. Great for home users or those 
re-entering the workforce. 

8 sessions, Tu./Th., 2/1 – 2/24, 6:00 – 8:00 p.m. Greenwood High 
$70.00 
Microsoft Excel, Beginning Elaine Smith, Instructor 
This class provides the foundation needed to use a spreadsheet for business and personal 
use. Design concepts, databases, & charts will be examined along with the major built-in 
functions. Keyboard & mouse skills are needed. 

3 sessions, Tu./Th., 2/8 – 2/15, 6:00 – 8:00 p.m. Warren Central High 
$35.00 
Microsoft Excel, Intermediate Elaine Smith, Instructor 
Dig a little deeper into the realm of Excel with this next class. Tap into formulas and more 
involved spreadsheets. Keyboard & mouse skills needed. PRE-REQUISITE: Knowledge of 
Beginning Excel or Beginning Excel class. 

3 sessions, Tue./Th., 2/22 – 3/1, 6:00 – 8:00 p.m. Warren Central High 
$35.00 
Getting Started on E-Bay Marcel Parent, Instructor 
If you hear others talking about selling or buying treasures on E-Bay, but are afraid to try it 
yourself, this is the class for you. Marcel is a veteran user of E-Bay services and is glad to 

share his knowledge with everyone. A fun and interesting class. (Laptops welcome) 
1 session, Tu., 3/1, 2:00 – 4:00 p.m. Community Education Office 
$15.00* 
Selling on E-Bay Marcel Parent, Instructor 
Take the next step with this medium and learn to sell your treasures. Learn the ins and outs 
of the system, how to place your items for great visibility, pricing, and more. (Laptops 
welcome) 

1 session, Thu., 3/3, 2:00 – 4:00 p.m. Community Education Office 
$15.00* 
Microsoft Word, Beginning Marcel Parent, Instructor 
Learn the basics of this user-friendly and extremely versatile program. Topics include: 
editing and navigating in Word, character and paragraph formatting, and controlling page 
appearance. Basic keyboarding and mouse skills are needed. 

3 sessions, Tue./Th., 3/1- 3/8, 6:00 – 8:00 p.m. Greenwood High 
$35.00 
2 
Microsoft Word, Intermediate Marcel Parent, Instructor 
In this continuation of Word, learn a few more skills such as creating labels, typing letters, 

and other great skills for work or home. 
3 sessions, Th./Tu., 3/10 – 3/22 (no class 3/17), 6:00 – 8:30 p.m. 
Greenwood High 
$35.00 
The Basics of Social Media for Business Use Marcel Parent, Instructor 
This workshop will help establish a certain level of familiarity and understanding of social 
media for businesses. It will help participants develop a feeling of how social networking 
may help them reach out and pull in a greater audience, provide a sense of the 
distinctiveness of different aspects of social media (blogging, Facebook, Twitter, 
and LinkedIn), and how to integrate social networking into marketing and outreach efforts. 
(Laptops welcome) 

1 session, Tu., 3/15, 1:00 – 5:00 p.m. Community Education Office 
$30.00 
Microsoft Power Point Elaine Smith, Instructor 
Preparing professional and/or fun presentations has never been easier. Learn how to do 
slideshow, training, and photo presentations. Can be used for work or to show off that last 
family vacation. 

2 sessions, Tu./Th., 3/22 – 3/24, 6:00 – 8:00 p.m. Warren Central High 
$35.00 

Contact  
BGWC Community 

Education 
 
1227 Westen Avenue 
 

PO BOX 1320  
 
Bowling Green, KY 
        42104   
 
Hours:  
M-F 8:00AM-4:30PM  
 
Phone:  
   270-842-4281 
 
Fax:  270-842-0554 
 

Email: 
info@commed.us  

 
www.commed.us 
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Automatically Selecting Words 
When you are editing your document, there are many times that Word tries to guess what you are doing and then 
complete your task for you. This helpfulness can be aggravating at times. One such instance is when you are trying to 
use the mouse to select text from the middle of one word to the middle of another. Whenever you click inside a word 
and then start dragging the mouse, Word assumes you want to make a selection. As soon as you move the mouse 
pointer outside the word, the program assumes you wanted to select the entire first word in which you originally 
clicked. 

 

                                                                  The Edit tab of the Options dialog box. 

 
             The Advanced area of the Word Options dialog box.  

 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission.                  
Thousands of free Microsoft Word tips can be found online at http://word.tips.net. 

If you want to ensure that Word doesn’t make 
that assumption, you need to follow these 
steps to turn off the offending feature in Word 
97 through Word 2003: 

1. Choose Options from the Tools 
menu. Word displays the Options 
dialog box. 

2. Make sure the Edit tab is selected. 

3. Make sure the When Selecting, Auto-
matically Select Entire Word check 
box is cleared. 

4. Click on OK. 

You can follow these steps if you are 
using Word 2007 or Word 2010: 

1. Display the Word Options dia-
log box. (In Word 2007 click 
the Office button, then choose 
Word Options. In Word 2010 
display the File tab of the rib-
bon, then click Options.) 

2. Click Advanced at the left side 
of the screen. 

3. In the Editing Options area, 
make sure the When Selecting, 
Automatically Select Entire 
Word check box is cleared. 

4. Click on OK. 
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Nationally known Speaker, Charlie Prince, will be at the February 22nd BGAMUG 
meeting.  Read what he has been doing over the past 40 + years: 

 

1969 & 1970 - attended junior college (now known as tech/community colleges) for an associate degree in computer pro-
gramming & operation. 

1972 to 2002 - applied for any position in the computer group at the local Dupont plant. There were no openings so I took 
another job. Worked for 30 years at the local Dupont plant. In the early '80s, the plant started switching to computer con-
trols. I was appointed the computer trainer for my work group while retaining my Chemical Plant Technician position.  

During this time I also owned several non-PC computers including a C64, C128, Amiga 1000, & Amiga 500. In 1995, I 
bought my first PC which was an Acer running W95. This computer had it's first virus in 1997 while using Norton which 
failed to protect the computer. After finding and deleting the files responsible for the virus, I had to learn to edit the regis-
try to repair the damage done and to remove Norton. This took a couple of days. 

This computer was upgraded to W98SE and was using McAfee when the second virus struck in late 1999 or early 2000. 
Again, I had to find & remove the files responsible plus edit the registry to repair the damage and remove McAfee. This 
took severals day to complete. 

The Summer of 2000 found me building my first PC. While searching the web for another antivirus, I came upon AVG 
free and installed that. It was a terrible install that took too much time and lugged the system down badly but I used AVG 
for about 1-1/2 years.  

In January 2002, I found Avast while again searching the Internet for an antivirus program. The uninstall of AVG was 
worse than the install taking me several days to complete. On the other hand, Avast installed easier than either of the 3 
antivirus I had used before. The computer ran like it was brand new with no perceivable slow down of the system. 

2004 - After 2 years using Avast, I joined the forum on February 14th out of an interest of learning more about Avast and 
why it worked so well when the more well known brands had failed me miserably in the past. I began to learn that as well 
as much more about malware. 

2005 - That Summer, I built my second computer and it is the desktop I am still using today. Of course, Avast was the 
first program installed after the OS. 

2006 - By this time, I had learned much more about malware and people who use computers. I had also risen to the rank 
of Avast Evangelist on the forum during this time period. 

2009 - Invited by Avast (along with several others) to a conference in Prague, CZ. There was also an Evangelists meeting 
and a resellers meeting. This was a week long trip. 

2010 - In the Summer, Avast asked me and another evangelist (also from the US) if we would be interested in becoming 
Spokespersons for Avast in the USA. We both said yes right away. The staff of Avast has a slow and deliberate way of 
doing things which I like very much. So, it was not until late November that my position & account was finalized. Our 
first job is to make the public more aware of the dangers of the Internet and of PC malware. 

2011 - Already this year, I have been requested  by the Avast CEO to be in Prague February 8th - 11th for an evangelists 
meeting as well as an information update on coming projects. 

I will also be attending the RSA security conference in San Francisco the week of February 13th - 19th with members of 
the Avast staff and a few other evangelists. 

During all these years of using Avast, there has not been an infection in any of my computers nor the other computers that 
I support though there have been many tries over the years. Avast either blocks them before the payload gets in or 
catches when it tried to execute. It has to be considered that I sometimes visit some very risky sites while researching mal-
ware for my own information as well as for seeking answers to problems posted on the forum.  
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BGAMUG 
P.O. Box 50882 

Bowling Green, KY   42102-4182 

BGA-bytes is online!  Please see http://www.bgamug.org 
 
    To see our online edition of the newsletter you will need Adobe Acrobat Reader installed  
on your computer.    If you do not have it, then please download and install Acrobat Reader by 
accessing;     http://www.adobe.com/ 

BGA-Bytes is the monthly newsletter publication of the 
Bowling Green Area Microcomputer User Group, Inc. (BGAMUG), 
which is a nonprofit, charitable educational society recognized by 
the Internal Revenue Service as a 501(c)3 tax-exempt charitable 
organization.  Donations to BGAMUG may be tax-deductible. 

The views expressed in BGA-bytes are those of the author(s) 
and do not necessarily reflect the official views of the organization. 
BGAMUG is a member of the Association of PC User Groups 
(APCUG) membership. 

BGAMUG holds regular presentation/membership 
meetings the fourth Tuesday of each month (except 
December) at the Bowling Green Technical College 
(BGTC) on Loop Drive in Bowling Green, Kentucky.  

 

The public is invited to attend our regular 
presentation meetings.  To join, our annual 
membership dues are $25 for an individual and $35 for 
a family.  

 

Loop drive intersects Morgantown Road just West of  
Warren Central High School. There is a stoplight at the 
intersection. The access road to BGTC from Loop is 
clearly marked with a sign. The meeting building is 
Building F . 

 ADVERTISING RATES  for BGA-Bytes  
SIZE            1 issue           12 issues 
Full             $50.00            $550.00 
Half            $30.00            $330.00 
Quarter Page     $15.00            $165.00 
Business Card    $10.00            $110.00 

Don’t forget our next meeting at  
the B G Technical College, 

F Building, January 25th,  6:30 PM 


